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Chapter 1

Overview

Welcome to the EmulationPro user’s manual, this document describes the Em-
ulationPro software and the basics of lighting programming.

EmulationPro is an advanced and scalable lighting control application. The
software is designed to control medium to large lighting installations, for both
architectural and live-entertainment situations.

This manual is written for EmulationPro version 1.4.28.

1.1 Features

• Cross-platform (Windows, macOS, Linux)

• 32 Universes (16,384 DMX channels)

• Industry-standard Cuelist system

• FX Generator

• Pixel Mapping

• DMX in

• MIDI in & out

• OSC in & out

• UDP in & out

• Art-Net in & out

• sACN out

• Timecode in (SMPTE, MTC, Art-Net)

• Astronomical Clock (sunrise, sunset)

• Scheduling (date, time, weekday)

• 3,500+ personality files

• Compatible with Kiosc remote control software
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1.2 User-interface

The main user-interface of EmulationPro consists of the following sections:

Figure 1.1: EmulationPro’s Graphical User Interface

1.3 Supported Hardware

EmulationPro works in combination with the ArtSSC and ArtIO as its DMX
and IO interfaces, the ArtB6 is supported as a remote control unit. All devices
are connected by Ethernet.

Multiple ArtSSC devices can be connected to EmulationPro in order to
achieve a large number of universes.

Chapter 10 on page 39 discussed the hardware in detail.

1.4 Licensing

The EmulationPro software is available for download. The licence is included in
the ArtSSC, i.e. each ArtSSC unlocks 2 universes in the EmulationPro software.

1.5 System

Figure 1.2 gives an example of a EmulationPro system. The diagram shows a
combination of ArtSSC devices to control a number of universes that exceeds
the capacity of one interface. It also illustrates the possibility to have the
EmulationPro software triggered by sensors (via an ArtIO) and a ArtB6 button
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panel. Finally, the software’s user-interface is enhanced by adding an optional
MIDI control surface.

Figure 1.2: System example

It is convenient to power the hardware unit via a POE (Power over Ethernet)
capable network-switch, however, the units can also be powered by their supplied
wall-mount PSU. The ArtB6 is an exception; this unit can only be powered
trough POE.

1.6 System Requirements

Please make sure your system has at least the following specifications.

• Intel i7 processor of equivalent

• 4GB RAM

• minimal screen resolution of 1280 x 800.

The following operating systems are supported:

• Windows 7

• Windows 8

• Windows 10

• MacOS 10.11

• MacOS 10.12

• Ubuntu Linux 16.04 (amd64)

Although EmulationPro might run on older OS versions, this is not covered by
Elation’ technical support.
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1.7 Further Help

If, after consulting this manual, you still have questions then you can obtain ad-
ditional information and help through the on-line support forum. EmulationPro
users and employees of Elation share their experiences and tips on this forum.
You can find the forum at http://forums.elationlighting.com.
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Chapter 2

Patch

The PATCH menu allows you to setup the DMX fixtures which are connected
to EmulationPro.

2.1 Universe

In the Universes tab you can set up the number of DMX universes that you
will be using. You can add, remove and rename universes. The maximum
number universes is 32. Each universe needs to be linked to a DMX port on a
ArtSSC. Each DMX port on a ArtSSC can only be linked to one universe. When
one DMX port becomes linked to a universe then EmulationPro will become the
’master’ of this ArtSSC. The ArtSSC will then suspend any standalone operation
and become solely an input/output interface for EmulationPro. When the DMX
port is unlinked from the universe or the EmulationPro software is closed, then
the ArtSSC will automatically resume its standalone operation.

Figure 2.1: Universe screen

The ArtSSC can also manually be unlinked from EmulationPro by disabling
the ’Master’ setting in the universes table.

When connected to a ArtSSC, each universe’s DMX data can also be send
out via Art-Net and/or sACN . EmulationPro supports both broad-cast and
uni-cast for transmitting Art-Net.
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2.2 Fixture

The Fixture tab allows you to add, remove and change the fixtures in your
patch.

Figure 2.2: Fixtures screen

2.3 Add

Click ADD to open the Add Fixture dialog. Browse the manufacturers list, and
choose the MANUFACTURER of the first fixture you would like to add.

Figure 2.3: Library dialog

To quickly find a manufacturer, start typing the name of the manufacturer
you’re looking for on your keyboard. While typing, the list will jump to the
correct manufacturer in the list. Browse the MODELs for the selected manu-
facturer and choose one by clicking it.

A special ’manufacturer’ to take into consideration is ’Generic’. This collec-
tion contains many typical DMX fixtures with common traits like dimmers and
RGB spots. It is likely that some of your DMX equipment will correspond with
items from the Generic list.

If you would like to choose a fixture that is not present in these lists then
please refer to page 56 to see how to obtain new personality files.
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2.4 Remove

To remove one or more fixtures from the patch, select them in the Patch view by
clicking or dragging and click REMOVE. To remove all fixtures, click REMOVE
and keep the button pressed for at least 1 second.

2.5 Replace

If you have pre-programmed a show with your fixtures, and find out these fix-
tures are running in a different mode or are even a completely different fixture
when on location, then you can ’replace’ these fixtures. Select the ’manufac-
turer’s’ field of fixtures you would like to replace by clicking or dragging in the
Patch view and click CHANGE. This will open the CHANGE FIXTURE dialog,
which is similar to the ADD FIXTURE dialog. Choose another mode for the
same model, or choose even another model.

2.6 Rename

To give your fixtures a more clear name, select the ’label’ cells of 1 or multiple
fixtures and press CHANGE. Type a new name for the fixture and click OK
or press <ENTER>. If youve renamed multiple fixtures, EmulationPro will
automatically add 01, 02, 03 etc. to the name you have entered.

2.7 Address

EmulationPro automatically sets the DMX address when adding fixtures to
the patch, by finding the first available DMX channel in your configuration.
However, if you want to change the address, select the ’address’ cell of 1 or
multiple fixtures and click CHANGE. Enter the new address and click OK.

Figure 2.4: Address dialog

If you had multiple fixtures selected, EmulationPro will set the entered ad-
dress for the first selected fixture and will automatically have the next selected
fixtures follow the previous ones. For example, if you select four 8-channel dim-
mers in the patch, click ADDRESS and enter 101. This will result in addresses
101, 109, 117 and 125 for the selected dimmers.
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2.8 Properties

Selecting the ’properties’ field of a fixture and clicking on the CHANGE button
will pop up the Fixture Properties window.

Figure 2.5: Properties dialog

This window allows you to enable INVERT PAN, INVERT TILT and SWAP
PAN TILT in case the fixture is a moving light.

If the fixture has RGB colour mixing but no DMX channel for intensity,
you can enable VIRTUAL DIMMER. This option will give the fixture dimmer
capability separate from the RGB control.
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Chapter 3

Matrix

EmulationPro contains a 2-dimensional matrix controller for pixel mapping on
arrays of lighting fixtures. These lighting fixtures are typically LED fixtures,
however, the matrix control can also be applied to any other DMX fixture.

3.1 Layout

To control a matrix you first patch the fixtures as usual in the Patch menu. The
next step is to add only the fixtures that are part of the matrix to the members
list in the Matrix->Layout menu. In this tab (figure 3.1) you can also set the
width and height of the matrix.

3.1.1 Positioning members

Next you should arrange them to reflect the physical location of the fixtures.
In the Layout tab you can select a matrix-member and then move it around
using the arrow-keys. The Snap to Previous button will position the member
on top of the previous member; this makes positioning faster as members are
often arranged as a ’snake’.

Figure 3.1: Layout screen

The Rotate button will clock-wise rotate the selected member(s) by 90 de-
grees.
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Alternatively, you could use Arrange All button to have all the members
automatically positioned according some typical patterns. See figure 3.2.

Figure 3.2: Arrange All dialog

3.1.2 Indicate

To assist you in establishing the layout you can enable the Indicate check-box,
this will make the lighting fixture to display the same colour as used in the layout
diagram. This will speed up the process because it helps you with recognizing
which fixture is selected and how it is orientated.

3.1.3 Export & Import

By using the Export button you generate a CSV file with all the members and
their position coordinates. The Import button reads these CSV files. This
function is useful for large or complex matrices were fixture positions can be
generated by external software tools.

3.2 Layer

Once the layout is created you should add at least one layer in the Layer tab
(figure 3.3). Typically this layer has the same dimensions as the matrix; this is
quickly achieved by pressing the Full Size button.

Figure 3.3: Layer screen

Each layer can playback a graphical effect. When you add more layers then
this will allow you overlay multiple effects and cross-fade or blend layers into
each other.
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By reducing the size of the layer you can create picture-in-picture effects.
Also, when two separate matrices are patches next to each other in the lay-
out then both could be covered by a separate layer; thus allowing independent
control of multiple matrices within EmulationPro.

3.2.1 Mix mode

The Mix mode setting determines how multiple layers are merged together.

3.3 Pattern

The Pattern tab (figure 3.4) shows the effects that are available to be played
back on the layers. When starting a new show-file the patterns are loaded by
default, however, you are free to add or remove any pattern. Some patterns
have properties that can be modified by using the Edit button.

The available patterns range from monochrome effects to full colour rainbow
effects. There is also a pattern for rendering text and static images such as JPG
and PNG files. The pattern for playback of video support AVI files. The
encoding used in the AVI files should match the installed video codecs on your
PC. Please note that at the time of version 1.4.28 video playback is not yet
functional in the macOS release of EmulationPro.

Figure 3.4: Pattern screen

3.4 Overview

The overview tab (figure 3.5) renders the output of the matrix control. When
using multiple layers then this overview shows the result of the layers merged
together.

3.5 Using the Matrix Control

For each layer that you have added a ’virtual’ fixture will appear in the status
menu (figure 3.6). This virtual fixture represents the layer. You turn on the
layer by selecting it and then creating a scene in the programmer window, just
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Figure 3.5: Overview screen

like you would be with moving light. The layer would need its intensity to be
brought up and a colour-mix to be set (typically open white), then by using
the gobo wheel you can select the pattern-page (gobo wheel 1) and the pattern
(gobo wheel 2). Some patterns benefit from the gobo scroll to be enabled, others
require the speed parameter that can is located on the Custom tab. When you
like the scene you have created for the layer then you can record it into a palette
or cue, just like you would do for a moving light.

Figure 3.6: Status screen
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Chapter 4

Groups

You can create groups with fixtures and/or sub-fixtures. This makes selection
of multiple (sub) fixtures easy and quick. To create a group you go to the Status
menu and follow the steps:

1. Make sure the programmer is cleared (press CLEAR twice)

2. Select fixtures

3. Press RECORD

4. Click on an empty cell in the group grid

Figure 4.1: Group dialog

You can also edit an existing group by enabling the EDIT button and then
click on a group cell. This will bring up the group dialog where you can add or
remove individual fixtures.

To rename a group you first enable the RENAME button and click on a cell.

4.1 Sub-Fixtures

EmulationPro uses the concept of sub-fixtures. This means that some fixtures
consist of multiple sub-fixtures, like a 10-channel dimmer rack is - in our terms
- just one fixtures with 10 sub-fixtures. This also works for LED fixtures with
multiple segments/pixels. The reason behind the concept of sub-fixtures is that
it makes patching easier; you only add the physical fixtures to your patch and
you dont have to worry about setting starting addresses per dimmer channel,
or worse, per LED segment.
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Chapter 5

Palettes

Palettes are memories that can contain a single lighting scene for one or more
fixtures. This scene can contain just a single attribute (e.g. only intensity)
or contain multiple attributes. When you activate a palette then the scene is
loaded into the programmer.

The palettes are useful for live controlling your lights as you can make quick
changes just clicking on different palette cells. Also, the palettes can be used to
store scenes into cuelists. In that case no actual values are stored into the cues,
instead a reference to the palette is saved. This allows you to later on change
the palette and have the change reflected in each cue that is referring to this
particular palette.

To create a palette go to the Status menu and simply build a scene in the
programmer window, enable the RECORD button and then click on an empty
palette cell. You can also edit an existing palette by enabling the EDIT button
and clicking on a palette cell. Similarly, renaming a palette is done via the
RENAME button and then choosing a palette cell.

Figure 5.1: Palette dialog

When you activate a palette then the behaviour depends on the fixture
selection. When no fixture is selected then clicking on a palette cell will first
select the fixture programmed in this palette. Clicking the cell again will activate
transfer the values to the programmer. If there are already fixtures selected then
clicking on the palette cell will apply the palette only of the fixture selection.
When there are fixtures selected that do not appear in the palette then the
values inside the palette will still be applied on these fixtures using a “let’s
make the best of it” policy.
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Chapter 6

Cuelists

A lighting scene is stored in a ’Cue’ and cues are stored in ’Cuelists’. Each
cuelist can contain one or more cues. You can create multiple cuelists that each
control a part of your show, or you can create one single cuelist that addresses
all your lights.

You can either create and change cues in the Status menu or use the Memories-
>Cuelist menu. This chapter discusses both approaches.

6.1 Tracking

Cuelist based lighting controllers can be either tracking or non-tracking. Emu-
lationPro is a tracking console. Tracking means that in a cuelist, only changes
need recording. If a light has the same value in two consecutive cues you don’t
need to store the second value, instead you make sure the second contains ’no’
value so the first value remains unchanged through those cues.

6.2 Creating cuelists in the Status menu

The fastest way to create cuelists is to do it in the Status menu. Special buttons
like RECORD, LOAD and KNOCKOUT are provided to make this process
intuitive.

6.2.1 Programmer

When recording cues, you first have to create a lighting scene which will be
then stored in the cue. The Programming window (figure 6.1) is the place
where you create the scene. First you select a fixture, the programming window
will update to show you the capabilities of that fixtures and enables you to set
the different parameters, e.g. set a dimmer level, pick a colour or gobo. You
can now also deselect the fixture and select a new one; the values will be kept
in the programming window’s memory.
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Figure 6.1: Programmer

6.2.2 FX

EmulationPro has an inbuilt FX generator for dynamic effects on the Intensity,
Position and ColourMix attribute. To enable a FX click on the FX-button close
to the attribute and choose an algorithm for the FX dialog (figure 6.2). You
also need to set the size, speed and phase levels.

Figure 6.2: FX Dialog

6.2.3 Clear

Any values that reside in the programming windows’ memory have priority. For
example you might have a cuelist running that sets a certain dimmer to 50% but
if the programming window contains a dimmer level of 10% for that particular
fixture, then this dimmer will be set 10%. Therefore it is important to clear
the programmer once you’re finished recording cues. Press the CLEAR button
once for clearing all values for the currently selected fixtures and press it twice
for clearing all values, even for fixtures currently not selected.
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6.2.4 Remove attributes

To remove an attribute from the Programmer-memory to make sure that it will
not be recorded in a Cue, press the KNOCKOUT button and click the Attribute
or Attribute-page in the Programmer to knock it out.

6.2.5 Fine Adjustments

Some fixtures support 16-bit values for controlling their attributes. To make
small changes to a value in order to take use of very fine 16-bit control, you can
use the CTRL key in combination with the mouse wheel to fine tune a fader’s
value.

6.2.6 Flip

A moving light of the yoke type - not a scanner - is, by using its fork and head,
able to reach a certain position through two different pan/tilt configurations.
When the programmer is containing position values for one or more fixtures
you can use the FLIP button to reach exactly the same position by using the
opposite pan/tilt values.

6.2.7 Record a cue

Once you’ve built up a scene in the programming window you can transfer the
values to a new cue by following the next steps.

• Press the RECORD button

• Press the GO button of an empty playback

This will create a new cuelist with one cue that contains the scene from the
programmer. The cuelist is automatically assigned to the playback. You can
repeat this process to add new cues to the cuelist.

6.2.8 Edit a Cue

To edit the cue, first make sure the cue is outputted by activating the cuelist
and stepping to the cue you want to edit using the PLAY button. Select the
fixtures you want to change and change the attributes in the Programmer. You
can also add other attributes by changing the attributes for the selected fixtures.
Other fixtures can also be added: Select them and change the values you would
like to store in the cue.

Press RECORD and click on the PLAY button of the cuelist where the cue
you want to edit is active. A window will pop-up, asking you what to do. Choose
MERGE to merge the active information in the Programmer with the cue.

6.2.9 Remove values or fixtures from a cue

To remove values or fixtures from a cue, were going to load the complete cue
into the programmer, make the changes, and store the programmer back into
the cue by replacing the old information.
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Figure 6.3: Record dialog

Make sure the cue is active by activating the cuelist and stepping to the cue
you want to edit using the PLAY button.

Load the cue into the Programmer by pressing LOAD and clicking on the
PLAY button of the cuelist. All information in the current cue is now loaded
into the Programmer. Performing a Load on a playback will automatically select
the fixtures programmed in its cuelist.

To remove a fixture from the Programmer, select the fixture and press
CLEAR in the Programmer once. To remove one or more attributes, select
the fixtures, press KNOCKOUT and click on the attribute or the attribute-
page; this action will delete the attribute or the complete attribute page from
the programmer.

To store the Programmer back into the cue, press RECORD and click the
PLAY button of the cuelist where the cue you want to edit is active. In the pop-
up window (figure 6.3) choose REPLACE to replace the cue with the information
in the Programmer.

6.3 Modifying a Cuelist via the menu

Next to working in the Status menu, you can also edit cuelists via the Memories-
>Cuelist menu. Although it is possible to create a new cuelist in the Cuelist
menu, the menu is more setup for modifying cuelists once created in the Status
menu.

To change an existing cuelist, open the Cuelist menu. Select a Cuelist and
click EDIT to open the Cuelist editor. Here you can edit the properties of the
CUELIST and the individual cues.

The following properties can be set for the cuelist:

6.3.1 Chase

When CHASE is enabled, the cuelist will no longer follow the cues’ timings and
conditions. The cuelist will be played back as a chase. The cross-fade can be
changed using the ATTAK slider in the playback settings. The speed of the
chase is linked to the main Chase tempo, which can be found at the bottom left

21



of the EmulationPro window. All cuelists set to CHASE will run synchronous
to this tempo. In the Cuelist Editor, you can also specify a tempo divider for
the chase.

1/1 Chase will step further on every beat of the main chase tempo

1/2 Chase will step further once in every 2 beats of the main chase tempo

1/4 Chase will step further once in every 4 beats of the main chase tempo

Etc.

6.3.2 Precedence

The precedence radio button (figure 6.4) determines how the output of the
cuelist will be merged with other cuelists. It can be set to HTP (Highest Takes
Precedence) and LTP (Latest Takes Precedence).

Figure 6.4: Precedence and Repeat properties

6.3.3 Repeat

This radio button (figure 6.4) allows you to change the behaviour of the cuelist.

• Setting it to Loop will make the cuelist repeat itself. This is the default
value.

• Bounce will make it run forwards and backwards.

• Random will make it jump to random cues.

• Off will make the cuelist automatically release when it reaches the end of
its cues.

6.4 Modifying a Cue via the menu

The following properties can be set per cue:

6.4.1 Label

The label is the name of the cue for your reference.
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6.4.2 Condition

The condition specifies when the cue will be triggered. There are 3 possible
conditions:

Halt The cue will be triggered when you press the GO button.

Follow The cue will be triggered as soon as the previous cue has finished fading.

Wait The cue will be triggered automatically after the previous cue has been triggered.

6.4.3 Cue Timing

To explain the different timings in combination with the Cue Condition, see the
following diagram:

Figure 6.5: Cue timing

Delay

The delay time (in seconds) is the time between the cue being triggered, and
the cue actually starting to fade.

Fade In

The Fade In time (in seconds) is the fade time for all dimmers fading in (dimmer
values going UP) in the cue and all other fading attributes (e.g. colour mix,
position).

Fade Out

The Fade Out time (in seconds) is the fade time for all dimmers fading out
(dimmer values going DOWN) in the cue. Click and drag to select multiple
properties for multiple cues, e.g. fade in for multiple cues or delay & fade in for
multiple cues
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6.4.4 Edit

The values in a cue can also be edited in the Cue Editor. Select a Cue and click
EDIT.

Insert

Use Insert to add an attribute to the cue.

Delete

Use Delete to remove an attribute from the cue. The attribute’s column will
still show until it is removed from every cue.

Change

Select one or multiple values and click Change to change the value.

6.5 Wizard

The wizard (figure 6.6) can automatically create typical cuelists that might have
taken quite a while to program if done by hand. To use the generated cuelist, it
still has to be assigned to a playback fader or button. See page 9 for instructions.

6.5.1 Chase

The wizard can create a chase over multiple fixtures (figure 6.7). You can select
any of the attributes that is supported by the fixtures you have selected. The
wizard also offers different orders in which the chase can run e.g. Forward,
Reverse, Zig Zag, Synchronous or Random (figure 6.8).

Figure 6.6: Wizard step 1

6.5.2 Test Sequence

The wizard can make you a cuelist that contains a sequence of steps for testing
fixtures. Based on the personality file of the selected fixture it will generate cues
for each attribute the fixture features. It is advised to create one test sequence
per type of fixture.
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Figure 6.7: Wizard step 2

Figure 6.8: Wizard step 3
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Chapter 7

Playbacks

Playbacks are an important element in a cuelist based lighting controller like
EmulationPro. Cuelists are not activated directly, instead they are assigned to
a playback. The playback allows the user to start (give the playback a ’Go’) and
stop (’release’ the playback) the cuelist, as well as controlling other parameters
like intensity, speed, attack, etc.

(a) Playback Faders

(b) Playback Buttons

Figure 7.1

There are two types of playbacks, playback faders (figure 7.1a) and play-
back buttons (figure 7.1b). They work in a similar way, the difference is that
a playback button does not feature the intensity fader and the flash button.
Therefor the playback button takes up less space in the EmulationPro user-
interface. Playback buttons are more suitable for controlling cuelists that have
fixed-value attributes like fixed colours, gobo, prism and shutter. On the other
hand, playback faders are better suited for controlling cuelists containing level-
value attributes like dimmer, RGB colour, iris, strobe, etc.

7.1 Assignment

You can assign a playback in two ways. Firstly, you can double-click on the ’in-
dicator’ just above a playback to bring up the Playback Settings view. Pressing
the Assign button in this dialog will bring up the assignment dialog.

Alternatively, you can also assign by creating a new cuelist in Status menu,
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(a) Indicator

(b) Dialog

Figure 7.2: Assignment

this implicitly assigns the new cuelist to a playback. Please refer to the Cuelist
chapter for an explanation on how this is done.

7.2 Indicator

The small rectangle above the playbacks are called ’indicators’, they provide
some basic feedback on the contents of the playback.

Figure 7.3: Indicator

7.3 Speed

The speed fader will control the overall speed of the playback. When set in the
middle the speed will be neutral; it will not effect the programmed speed of the
cues and fades.

If the cuelist is set as a chase then the cuelist will no longer follow the cues
timings and conditions. The speed of the chase is linked to the main Chase
tempo, which can be found at the bottom left of the EmulationPro window.
All cuelists set to CHASE will run synchronous to this tempo. In this case the
Speed slider will specify a tempo divider/multiplier for the chase. For example:
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4/1 Chase will make four steps within every beat of the main chase tempo.

2/1 Chase will make two steps within every beat of the main chase tempo.

1/1 Chase will step further on every beat of the main chase tempo.

1/2 Chase will step further once in every two beats of the main chase tempo.

1/4 Chase will step further once in every four beats of the main chase tempo

7.4 Attak

When the cuelist is set as a Chase, then the cross-fade can be changed using
the ATTAK slider.

7.5 FXRate

The FXRate will modify the programmed speed for all FX in the cuelists. Keep-
ing this slider in the middle will not change the programmed FX speed.

7.6 Background

If a playback is set to ’background’ then it will start running automatically at
the software’s startup. Also, it will not be released by the ’release all’ command
(a ’release all’ is performed when the RELEASE button is pressed for over one
second).

The background feature is useful for cuelists controlling fixtures that should
not be turned off during a show, e.g. ’work’ lights backstage.

7.7 Fader Start

With Fader start enabled, the playback will automatically be triggered when
the corresponding fader is being moved up or the flash button is pressed. The
playback will also be released as soon as the fader is back at the bottom or when
the flash button is released.

7.8 Bundle

You bundle playbacks together so they work mutually exclusive; i.e. only one
playback is active at the same time. Whenever you start a playback it will
automatically release any other playback in the same bundle. Use the Bundle
dialog (figure 7.4 to apply the same bundle number to the playbacks that should
cooperate in this way. You can set up to 20 different bundles.

Bundles come in handy if you have a couple of playbacks controlling cuelists
for the same fixtures, especially if those cuelists contain HTP attributes like
dimmer.
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Figure 7.4: Bundle dialog

7.9 Button Primary/Secondary

These properties allow you change the function of the flash button (Primary)
and the go+ button (Secondary).

7.10 Banksafe

Some cuelists you will need to change so frequently, that you would like to access
them from each bank. In the Playback Settings, you can achieve this quickly
by clicking BANKSAFE.
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Chapter 8

Actions

EmulationPro needs to respond to the outside world. With today’s ever more
demanding lighting projects, chances are it needs to respond to various different
signals or protocols. The EmulationPro software supports a variety of protocols.
In the Memories->Action menu (figure 8.1) you determine how your ArtSSC
will respond to which signal and what tasks it will perform when triggered.

Figure 8.1: Action menu

This structure consists of actionlists and actions. All the different kind of
signals EmulationPro can receive are categorized as ’sources’. Each actionlist
relates to one source and can contain multiple actions. Each action details to
which specific signal it is listening and contains a list of tasks it will perform
when triggered. Actionlists and actions are discussed later on in this chapter.

8.1 Templates

The Memories->Action menu provides ready-made templates for several typical
action arrangements. Templates can be easily copied to the Source list and
modified in necessary. Appendix A gives an overview of the available templates.
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8.2 Actionlists

Programming the show controller involves adding actionlist and specifying ac-
tions. In the Actionlists table you can include the sources you will be using in
your project. Each Actionlist can be enabled and disabled.

The available sources are:

Touch Screen Triggers from the Kiosc software tool.

Art-Net Trigger on reception of Art-Net or convert Art-Net universes to DMX.

DMX In Convert to complete universe to Art-Net or trigger by individual DMX
channels.

MIDI Trigger by or convert from incoming MIDI messages like Notes, Control
Changes or Program Changes.

Timecode Trigger by exact time-code frames. You specify the time-code protocol in
the settings page.

Scheduler The inbuilt RTC allows triggering on time, day, weekday and
sunrise/sunset.

System Miscellaneous triggers like ’OnStartup’

OSC Incoming OSC messages

GPI State changes on the ArtSSC’s or ArtIO’s GPI port.

GPO State changes on the ArtIO’s relays.

UDP Incoming UDP messages

8.3 Actions

Within each Action-list you can create multiple Actions. For each Action you
specify when it will be triggered and which Tasks it will perform when that
trigger occurs. To change the details of an action, select it and press the EDIT
button. This will open the Action page (figure 8.2).

8.4 Flank

For most types of actions you can set the flank. For example when editing a GPI
action, it will be triggered only on closing the contact (also known as ’normally
open’) when the specifier is set to DOWN. When set to UP, the action will be
only trigger on opening the contact (a.k.a. ’normally closed’). Finally, when
the specifier is set to CHANGE, the action will be triggered on both closing and
opening of the contact.
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Figure 8.2: Action page

8.5 Trigger

Specify the exact trigger on which to execute the tasks. In the case of a GPI
action, the trigger denotes the trigger port number (there are 4 ports on the
ArtSSC and 8 ports on a ArtIO).

8.6 Tasks

You can specify up to 64 Tasks per action. When triggered, the Tasks are per-
formed in the same order as they are listed in the Action. Tasks can control
various elements and protocols in EmulationPro, such as playbacks, MIDI, OSC
or fixture selection. Tasks can also be used to trigger other Actions, enable or
disable action-lists and start/stop the internal time-code. Some tasks manipu-
late the software entities in the engine and other tasks control the user-interface
of EmulationPro; the latter are called ’Dashboard’ tasks. For example there is
a ’Playback Fader’ task and a ’Dashboard Playback Fader’ task. The ’Playback
Fader’ task has features like ’Go+’ and ’Release’, directly changing the state
of the playback. The ’Dashboard Playback Fader’ task does, however, only
control the buttons and faders in EmulationPro that belong to that particular
playback. This task allows you to press and release the ’flash’ and ’go’ button.
Because a Task can do a wide variety of things they are organized in different
Task ’Types’. When adding a task a pop-up window will allow you to choose
from the following types. These types are listed in detail in appendix C.

8.7 Feature

For each task you can select a Feature. The choice in Features differs for each
Type.

8.8 Function

Each Task also has a Function field. The choice of Functions depends on the
Task-Type and the selected Feature. For example, when you add a Task with
the ’Playback Fader’ Type and set its Feature to ’Intensity’ then you can select
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of the following Functions:

Set Specify an intensity level.

Control Set the intensity to the level that is provided as an argument from the source
that triggered this task. For example, if this task was triggered by the DMX
input then the level of the DMX channel will be used for the intensity level.

8.9 Scheduling

An important input Source is the Scheduler. The Scheduler uses the computers
system time. There are several ways to specify a trigger.

8.9.1 Date and Time

You can use the Scheduler to trigger actions on certain dates and times (figure
8.3). When specifying a date and time it is possible to choose ’Don’t Care’ for
each value by entering ’X’. E.g. if you set a date and specify ’Don’t Care’ for
the year field, this Action will be triggered each year.

Figure 8.3: Date & Time

8.9.2 Weekday and Time

Sometimes you would like to define a trigger based on a day in the week, rather
then a specific date. EmulationPro supports this, it allows to choose any com-
bination of weekdays and time (figure 8.4).

8.9.3 Astronomical Clock

EmulationPro keeps an astronomical clock that based on the day of the year
and position on the globe (as configured in the settings page) calculates the
sunrise and sunset times. This allows you to trigger events on sunrise or sunset.
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Figure 8.4: Weekday & Time

34



Chapter 9

Kiosc

Kiosc is a simple app for creating custom user-interface. This app (see figure
9.1) is available on many operating systems (iOS, Android, Windows, macOS
& Ubuntu Linux). It can remote control lighting controllers from Elation such
as EmulationPro, ArtSSC2, ArtIO and the ArtB6.

Figure 9.1: Kiosc

9.1 Connecting

The Kiosc app connects to a host (e.g. EmulationPro or ArtSSC) by Ethernet.
Make sure all devices are within the same IP range. The Kiosc app is able to
discover the hosts on the network, as seen in figure 9.2.
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Figure 9.2: Connecting to a host

9.2 Designing the layout

The app features control elements like buttons, sliders, colour-pickers, clocks,
etc. The layout of Kiosc is programmed by adding an actionlist with source
’Touch Screen’. This actionlist allows the control elements to be inserted. The
order of the elements determines the location on the Kiosc screen. Also, the
Kiosc app has a option that allows you to set the ’grid size’ of the screen (see
figure 9.3).

9.3 Password protect

Kiosc can be used to provide a fool-proof user-interface to people that should
choose lighting presets without being able to alter settings in the system. For
this purpose a password PIN code can be enabled. This setting is found in
Kiosc’s settings page, see figure 9.4.

9.4 Requirements

The minimal system requirements for Kiosc are:

• iOS 8.0 or higher

• Android 5.0 or higher

• Windows 10

36



Figure 9.3: Choosing in Grid size

Figure 9.4: Enabling the PIN
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• macOS 10.11 or higher

• Ubuntu Linux 16.04 (amd64)

9.5 Installing Kiosc

You can obtain Kiosc via the iOS Appstore, Google Playstore, Windows App-
store and macOS Appstore

On Ubuntu, you can acquire the Kiosc app from the uApp Explorer or install
it by using the command-line:
snap find kiosc

snap install kiosc
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Chapter 10

Hardware

The EmulationPro software works together with the ArtSSC2, ArtSSC1, ArtIO
and ArtB6 hardware. To unlock the software you need at least one ArtSSC.
You can add more ArtSSC s to unlock more DMX universes. ArtIO s can be
added provide GPI triggers or switch external equipment with the GPO relays.
ArtB6 s provide a physical user-interface to select for example cues, palettes or
other effects.

Once the ArtSSC is connected to the EmulationPro software it becomes
’mastered’ and will act as input/output interface; outputting the Emulation-
Pro’s data via the DMX outputs. And in the case of a ArtSSC it will as well
capture incoming DMX, MIDI, timecode and GPI triggers in real-time.

10.1 ArtSSC2

The ArtSSC 2 (figure 10.1) is a two universe interface for EmulationPro. Its
DMX port can be set as output or as input. The unit also features MIDI ports,
a SMPTE input, a four-port GPI interface and internal memory to hold lighting
content that can be played back in standalone mode.

Figure 10.1: ArtSSC2
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10.2 ArtSSC1

The ArtSSC1 (figure 10.2) is the interface originally designed for EmulationPro.
It features two DMX outputs, one DMX input, MIDI, SMPTE input and 4x
GPI. The ArtSSC1 is also fitted with internal memory to playback lighting
content in standalone mode.

Figure 10.2: ArtSSC1

10.3 ArtIO

The ArtIO (figure 10.3) is a interface for adding GPI and GPO ports to Emula-
tionPro; it does not unlock any universes. Additionally, the ArtIO also features
a RS-232 port and a DMX port that can be used as DMX input into Emula-
tionPro. The ArtIO will not unlock any universe in EmulationPro.

Figure 10.3: ArtIO

10.4 ArtB6

The ArtB6 (figure 10.4) is a wall-mount button panel that can be used to trigger
presets in EmulationPro. The unit features 6 buttons that contain white LED
lighting. The ArtB6 will not unlock any universe in EmulationPro.
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Figure 10.4: ArtB6

10.5 Dumping content into the ArtSSC

Once the ArtSSC is connected to the EmulationPro software it becomes ’mas-
tered’ and will act as input/output interface; capturing incoming DMX, MIDI,
timecode and GPI triggers in real-time as well outputting the EmulationPro’s
data via the DMX outputs.

The ArtSSC also has many features for standalone usage, making it a pow-
erful and compact solid-state lighting controller. The lighting scenes can be
programmed via the ArtSSC’s web-interface or captured via DMX or Art-Net
input. Alternatively, you can use the EmulationPro software to program the
standalone memory of the ArtSSC.

The ArtSSC1 has two type of memory: Cues in the ’console’ page and
Recordings in the ’Recorder’ page; both can be uploaded by EmulationPro. To
program the cues simply create a lighting scene and dump this ’DMX snapshot’
into one of the 255 available cues by pressing the DUMP button and entering
the cue number followed by ENTER. The command-line would show for exam-
ple:
> DUMP 3

You can also store a cuelist into the recording memory of the ArtSSC1. First
you create a cuelist and assign it to playback. Then press the DUMP button,
then press the playback’s GO button, enter the recording number followed by
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enter. In the command-line it would show like:
> DUMP PB2 12

When the cuelist has multiple cues and their conditions are set to follow,
then the complete cuelist will be stored taking into account the programmed
delay and fade times.

When the current cue in the cuelist has a condition set to halt, then only that
cue is stored. If this cue contains any matrix patterns or intensity FX, colour
FX or other FX then the duration of the FX will be used for the recording.
In this case, EmulationPro will automatically make sure the pattern of FX will
make one complete cycle in order to record a seam-less loop.

When your patch is spread out over multiple ArtSSC s, EmulationPro will
distribute the generated DMX data over the recording in the various ArtSSC s.
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Chapter 11

Tempo

All cuelists with property CHASE enabled, are synced to the Tempo. You can
find the controls for the Tempo on the bottom left of the EmulationPro window
. Using the TEMPO button below the tempo display, you can tap to the music
to change the tempo in EmulationPro. You can also click the tempo display
and drag up (tempo UP) or to the right (tempo DOWN).

11.1 Break

Click the BREAK button below the tempo display to pause all chases. Click
again to continue all chases.

11.2 MIDI Clock

When the MIDI Input device youve selected in the MIDI Options (see chapter
MIDI Controllers) sends out MIDI Clock messages, the Tempo will be automat-
ically locked to the MIDI Clock tempo. This allows exact tempo matching when
controlling EmulationPro from sequencer software for example at a concert.

In order for the tempo to be controlled by the MIDI Clock, the display
should be set to ’midi’ mode. Press the TEMPO button for more than one
second to switch to ’midi’ mode. Press the TEMPO again to switch back to
’manual’ mode.

(a) Manual mode (b) MIDI mode
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Chapter 12

MIDI

EmulationPro supports various MIDI control surfaces. The buttons and faders
on those controllers are assigned to features in the EmulationPro User-interface
in a pre-defined midi-map. The following diagrams illustrate those assignments.

12.1 Generic Midi-map

Next to the hardware specific midi-maps, EmulationPro also offers a generic
midi-map in which all the software functions that can be controlled through
MIDI are assigned to Note or Control Change message. This midi-map is in-
tended for use with external MIDI software like sequencers or DAWs.

12.2 Elation Midicon

The Elation Midicon (figure 12.1) is supported Plug & Play.

12.3 Elation Midicon2

The Elation Midicon2 (figure 12.2) is supported Plug & Play.

12.4 Elation MidiconPro

The Elation MidiconPro (figure 12.3) is supported Plug & Play.

12.5 Behringer BCF-2000

The Behringer BCF-2000 (figure 12.4) is supported Plug & Play: However, for
optimal use we’ve included a Sysex-file that can either be found in the Program
Files/Elation/EmulationPro/Sysex/ folder on Windows systems, or it can be
obtained via the technical support forum.

The Sysex file can be uploaded to the BCF-2000 using one of the following
(free) tools:
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Figure 12.1: Elation Midicon

Figure 12.2: Elation Midicon2

• Midi-OX for Windows: http://www.midiox.com

• SyEx Librarian for Mac OS X: http://www.snoize.com/SysExLibrarian

After sending the Sysex file to the BCF-2000, please notice that the received
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Figure 12.3: Elation MidiconPro

preset is in a temporary memory. If you switch off the BCF-2000, the preset
will be lost. When you’ve received the preset on the BCF-2000, press STORE,
use the PRESET buttons to choose a preset number for storing the preset, and
press STORE again. The preset will be saved in the BCF-2000.

12.6 Behringer X-Touch Compact

The Behringer X-Touch Compact (figure 12.5) is supported Plug & Play.

12.7 Livid Instruments Ohm64

The Livid Instruments Ohm64 (figure 12.6) is supported Plug & Play.

12.8 Novation Launchpad

The Novation Launchpad (figure 12.7) is supported Plug & Play.
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Figure 12.4: Behringer BCF-2000

Figure 12.5: Behringer X-Touch Compact

47



Figure 12.6: Livid Instruments Ohm64

12.9 Korg nanoKontrol

The Korg nanoKontrol (figure 12.8) and nanoKontrol2 are supported Plug &
Play.

12.10 Akai APC Mini

The Akai APC Mini (figure 12.9) is supported Plug & Play.
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Figure 12.7: Novation Launchpad
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Figure 12.8: Korg nanoKontrol

Figure 12.9: Akai APC Mini
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Chapter 13

OSC

Open Sound Control (OSC) is a protocol for communicating between computers,
software and various multi-media type devices. OSC uses the network to send
and receive messages, it can contain MIDI and custom information.

There are apps available for creating custom-made user interfaces on iOS
and Android. These tools allow you to program fool-proof user-interfaces for
controlling the device. E.g. TouchOSC from http://hexler.net/software/

touchosc.

13.1 Remote Control

EmulationPro has an inbuilt implementation for remote controlling the software
by OSC. This implementation exist independent from any OSC handling you
might program in the action editor.

Figure 13.1: Remote control
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13.2 Actions

You can also trigger to incoming OSC messages and define yourself the actions
that need to be performed. You just add an OSC source to the actionlist in
the Memories->Action menu and specify the actions, triggers and tasks. More
information about programming actions can be found on page 30.

13.3 Forwarding

Some OSC apps can only send its OSC messages to one IP address, however,
sometimes you need to send it to multiple IP addresses. In that case you can
use the OUTPUT IP OSC table in the Options->Communication->OSC &
UDP menu. Simply add IP addresses to this table and enable the FORWARD
check-box.
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Chapter 14

Options

The Options menu enables you to change preferences and view various settings.

14.1 General

This tab (see figure 14.1 enables you to choose a language and a screen resolu-
tion.

Figure 14.1: General options

The astronomical clock in the EmulationPro calculates the sunrise and sun-
set times based on day of the year, latitude, longitude and UTC values.

The latitude and longitude values define your position in the world and
should be entered in degrees. The latitude value should be positive for North
and negative for South, the longitude should positive for East and negative for
West. The website http://www.findlatitudeandlongitude.com can help you
find the latitude and longitude values for your location.

The time-zone and perhaps daylight saving time of your location is expressed
in the UTC (Coordinated Universal Time) value. UTC is in this context
equivalent to GMT (Greenwich Mean Time).

For example, Elation’s HQ is based in Commerce, California USA. During
the winter we are UTC -8 and in the summer during day light saving time we
are UTC -7. See the settings in figure 14.2.

53

http://www.findlatitudeandlongitude.com


Figure 14.2: Location settings

14.2 Communication

In this tab you can select the midi-maps for the attached MIDI control surfaces.
You can specify two MIDI devices.

EmulationPro supports various MIDI control surfaces; it allows you to con-
trol EmulationPro’ user interface (UI) through the buttons and faders on the
MIDI controller. The software ships with a list of predefined Midi-maps. A midi-
map file describes the MIDI controller and how its features (buttons, faders, etc)
are mapped to the EmulationPro UI.

To set up EmulationPro for use with your MIDI controller, select the ap-
propriate INPUT DEVICE and optionally an OUTPUT DEVICE. The output
device is used by EmulationPro to provide feedback to MIDI controller’s LEDs
and motorized faders. Then select the MAP that corresponds to your MIDI
controller.

Figure 14.3: Communication options

Please take into account that the MIDI controller needs to be connected
to the computer before EmulationPro starts up; EmulationPro only scans for
MIDI devices at start up. After that you would need to use the REFRESH
button to scan again.

Please refer to page 44 for diagrams describing the layout of various Midi-
maps.

This tab also allows you to change the settings for OSC and UDP com-
munication. You can change the default network ports used for listening to
incoming OSC and UDP messages. Also, you can have incoming OSC or UDP
messages forwarded to other IP addresses. For this you add the ipaddress:port
information to the OUTPUT IP OSC and OUTPUT IP UDP tables.

Furthermore, you can specify the incoming time-code protocol used by Em-
ulationPro.
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14.3 File

The File tab allows you to load and save show-files. A show-file contains all
information about the patch, playback assignments, cuelists, etc. You don’t
need to save your show-file as EmulationPro will check for changes every few
seconds and automatically save the file if needed.

Figure 14.4: File options

By saving manually and choosing a name for the show-file you can manage
different lighting projects or create backup versions. The show-files are stored
in XML format at the following locations:

Windows C:\Users\[username]\Documents\Elation \EmulationPro

macOS /Users/[username]/Elation/EmulationPro

Ubuntu Linux /home/[username]/Elation/EmulationPro

By copying the show-file you can easily transfer your show between different
computers or even Operating Systems.

14.4 About

This tab displays the software’s version number.
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Chapter 15

Personalities

Most fixtures differ in the way how they are controlled by DMX. EmulationPro
reads ’personality files’ (sometimes referred to as ’profiles’) to determine a fix-
ture’s DMX traits. When you patch a fixture you need to choose your fixture
from a list of supported personalities (as described on page 7). This chapter
describes how to obtain additional personality files in case your fixture is not
yet present in our list.

15.1 Generic

Some types of fixtures typical have identical DMX traits. These common fix-
tures (e.g. Dimmers, fog generators, RGB LED fixtures) are represented in the
’Generic’ collection in our library.

15.2 Request new personalities

Elation provides a free-of-charge service for creating personality files on request.
Please make the request on the Elation Forum (http://forums.elationlighting.
com) and include a link to the user-manual or DMX-chart of your fixture.

When you receive the file from Elation it needs to be copied into the follow-
ing location, before starting up EmulationPro:

Windows C:\Users\[username]\Documents\Elation \Common\Personalities\Factory

macOS /Users/[username]/Elation/Common/Personalities/Factory

Ubuntu Linux /home/[username]/Elation/Common/Personalities/Factory

15.3 Create your own

Sometimes it is better to create your own personality file, maybe you need it
urgently and you’re outside office hours. Or perhaps you don’t have a manual
available so you would need to create a file through trial-and-error, testing it on
the physical fixture.

56

http://forums.elationlighting.com
http://forums.elationlighting.com


For any of these cases we supply an editor for creating the personalities
yourself; the Personality Builder. It is an external tool for creating and mod-
ifying the personality files used by EmulationPro. The eBuilder is supplied
free-of-charge for all EmulationPro users and can be downloaded from http:

//www.emulationcontrol.com/downloads.
For a detailed description of this editor please read its user manual.

57

http://www.emulationcontrol.com/downloads
http://www.emulationcontrol.com/downloads


Appendices
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Appendix A

Templates

This appendix discusses the templates provided in the Show Control page.

Template Description

GPI ->Dashboard Playback Button Assigns 8 GPI (digital) ports from an ArtIO to the 8
playback buttons in the EmulationPro GUI.

GPI ->Playback Fader + Dimmer Assigns 8 GPI (digital) ports from an ArtIO to the 8
playback faders on bank 1. A short press will toggle
the playbacks, a long press will adjust the intensity.
The playbacks are supposed to have ’fader start’
enabled.

DMX ->Playback Fader Assigns the first 8 channels on the DMX input to the
8 playback faders on bank 1. The playbacks are
advised to have ’fader start’ enabled.

Kiosc ->Playback Faders Provides a Kiosc layout for controlling the playback
faders. The Kiosc app is discussed on page 35.
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Appendix B

Trigger Types

The following tables list the different types of triggers that can be used in the
EmulationPro. The different types are accompanied with values and flanks.

B.1 Touch Screen

Trigger Type Trigger Value Flank Description

- - Change Button/Fader goes up or down

- - Down Button is pressed

- - Up Button is released

B.2 DMX In

Trigger Type Trigger Value Flank Description

Channel DMX address Change Channel changes

Channel DMX address Down Channel becomes non-zero

Channel DMX address Up Channel becomes zero

Receiving - Change Start receiving or loose Art-Net signal

Receiving - Down Lost Art-Net signal

Receiving - Up Start receiving Art-Net signal

60



B.3 Art-Net

Channel DMX Address Change Channel changes

Channel DMX Address Non-zero Channel becomes non-zero

Channel DMX Address Zero Channel becomes zero

Receiving - Change Start receiving or loose Art-Net signal

Receiving - Stop Lost Art-Net signal

Receiving - Start Start receiving Art-Net signal

B.4 MIDI

Trigger Type Trigger Value Flank Description

Message Address Change Receive a message that matches the address

Message Address Down Receive a message that matches the address and
the value non-zero

Message Address Up Receive a message that matches the address and
the value is zero

Receiving - - Receive any message

MIDI address can be any note-on, note-off, control-change, program-change
and machine-control.

B.5 Scheduler

Trigger Type Trigger Value Flank Description

WeekdayAndTime - - Enable weekdays and specify a time (don’t
care ’X’ can be used)

DateAndTime - - Specify a specific date and time (don’t care
’X’ can be used)

Sunrise - - When the sun rises in the morning

Sunset - - When the sun goes down in the evening

B.6 System

Trigger Type Trigger Value Flank Description

Startup - - Trigger when EmulationPro is started up

Shutdown - Start Trigger when EmulationPro is shut down
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B.7 GPI

Trigger Type Trigger Value Flank Description

Channel Port number Change Port state changes

Channel Port number Down Port is closed

Channel Port number Up Port is opened

Binary Combination value - A combination of ports being closed

ShortDown Port number - A short press on a digital GPI port

LongDown Port number - A long press on a digital GPI port

Use the Binary trigger type to catch port combinations when they are set as
digital. Specify the port combination by adding the values that correspond to
the ports (see table below). This value is entered as the trigger value.

Port Value

1 1

2 2

3 4

4 8

For example, to trigger on both port 1 and 2 being closed fill in trigger value 3
(1+2). To trigger on port 5 and 6, fill in value 48 (16+32).

B.8 UDP

In the UDP source there is no choice in trigger types. Specify a ASCII string in
the trigger value. The action will fired when an incoming UDP message matches
this ASCII string.

B.9 OSC

In the OSC source there is no choice in trigger types.
The user can define his own URI as the trigger value of a message, however,

the OSC specification dictate this string must start with a ’/’ sign. Please note
that this string has a maximum length of 31 characters, including the ’/’.

B.10 Serial

In the Serial source there is no choice in trigger types. Specify a ASCII string
in the trigger value. The action will fired when an incoming RS-232 message
matches this ASCII string.
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B.11 Timecode

B.12 Dashboard Master

B.13 Dashboard Tempo

B.14 Dashboard Selection

B.15 Dashboard Programmer

Trigger Type Trigger Value Flank Description

WheelActive - -

WheelValue - -

WheelLabel - -

B.16 Dashboard Bank Fader

B.17 Dashboard Bank Button

B.18 Dashboard Playback Fader

B.19 Dashboard Playback Fader Grid

B.20 Dashboard Playback Button

Trigger Type Trigger Value Flank Description

ButtonSecundair - -

B.21 Dashboard Playback Button Grid

Trigger Type Trigger Value Flank Description

ButtonSecundair - -
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B.22 Dashboard Playback Global

B.23 Dashboard Group

Trigger Type Trigger Value Flank Description

ButtonPrimair - -

WheelLabel - -

Selection - -

B.24 Dashboard Fixture

Trigger Type Trigger Value Flank Description

ButtonPrimair - -

WheelLabel - -

Selection - -

B.25 Dashboard Palette

Trigger Type Trigger Value Flank Description

ButtonPrimair - -

WheelLabel - -

Selection - -

B.26 Playback Fader

Trigger Type Trigger Value Flank Description

Intensity Playback ID - Playback’s intensity level changed

Speed Playback ID - Playback’s speed level changed

Attack Playback ID - Playback’s attack level changed

Flash Playback ID - Playback’s flash button changed

State Playback ID - Playback changed its play-state

Go+ Playback ID - Playback did a Go forward

Go- Playback ID - Playback did a Go back

Release Playback ID - Playback has been released
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B.27 Playback Button

Trigger Type Trigger Value Flank Description

State Playback ID - Playback changed its play-state

Go+ Playback ID - Playback did a Go forward

Go- Playback ID - Playback did a Go back

Release Playback ID - Playback has been released
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Appendix C

Task Types

Tasks allow you to automate the functionality in EmulationPro. All this func-
tionality is categorized in task-types. This appendix provides a listing of the
various task-types. The tables present an overview of all available features and
functions per task-type.

C.1 GPO

Control the GPO relays in an ArtIO.

Feature Function Parameter 1 Parameter 2

Port Set Port [1,8] On/Off

Port Toggle Port [1,8] -

Port Control Port [1,8] -

Port Inverted Control Port [1,8] -

Port Pulse Port [1,8] Duration (s)

Binary Set String -

Binary Toggle String -

Binary Control String -

The Binary feature allows you to send a string of 8 characters to the ArtIO. Use
a 0 to switch off a port, a 1 to turn on and a X to leave the port unchanged.
For example the string 000XX111 will switch off port 1-3, leave port 4-5 as it is
and turns on port 5-8.

C.2 DMX

Manipulate the DMX levels. These levels can be send out via Art-Net or sACN.
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Feature Function Parameter 1 Parameter 2

Set Value Set DMX Channel DMX Value

Set Value Toggle DMX Channel -

Set Value Control DMX Channel -

Set Value Inverted Control DMX Channel -

Bump Set DMX Channel DMX Value

Bump Control DMX Channel -

C.3 MIDI

Send an MIDI message.

Feature Function Parameter 1 Parameter 2

Send Message Set MIDI Address MIDI Value

Send Message Control MIDI Address -

Send Message Inverted Control MIDI Address -

Send Message Control Launchpad MIDI Address -

Send Message Control APC40 MIDI Address -

Send Message Control OhmRGB MIDI Address -

C.4 OSC

Send an OSC message via the network. The recipient can be specified in the
identifier field. For example 192.168.1.11:8000. If the identifier is set to
0.0.0.0:0 then the OSC messages is send to all IP addresses in the ’ouput IP
OSC’ table in the Communication options (see page 54).
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Feature Function Parameter 1 Parameter 2

Send Float Set URI floating point number

Send Float Control URI -

Send Unsigned Set URI positive number

Send Unsigned Control URI -

Send Bool Set URI true or false

Send Bool Control URI -

Send String Set URI String of characters

Send String Control URI -

Send Colour Set URI RGB colour

Send Colour Control URI -

C.5 UDP

Send an UDP message via the network. The recipient can be specified in the
identifier field. For example 192.168.1.11:7000. If the identifier is set to
0.0.0.0:0 then the UDP messages is send to all IP addresses in the ’ouput IP
UDP’ table in the Communication options (see page 54).

Feature Function Parameter 1 Parameter 2

Send Float Set floating point number IP address & port

Send Float Control - IP address & port

Send Unsigned Set positive number IP address & port

Send Unsigned Control - IP address & port

C.6 Timecode

Manipulate the internal timecode generator.
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Feature Function Parameter 1 Parameter 2

Playstate Start - -

Playstate Stop - -

Playstate Restart - -

Playstate Pause - -

Playstate Toggle Start Pause - -

Playstate Toggle Start Stop - -

Time Set - Timecode frame

Source Set Source -

Source Toggle Source Source

Source Increment - -

Autonoom Pause Set On/Off -

Enable Set Source On/Off

C.7 Selection

Manipulate the fixture selection.

Feature Function Parameter 1 Parameter 2

Set - - -

Toggle - - -

All - - -

Clear - - -

Next - - -

Previous - - -

Odd - - -

Even - - -

Invert - - -

C.8 Special

Miscellaneous functionality.

Feature Function Parameter 1 Parameter 2

Run program Set path -
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C.9 Pattern

Manipulate a matrix pattern.

Feature Function Parameter 1 Parameter 2

Parameter Bool Set Parameter name On/Off

Parameter Bool Toggle Parameter name -

Parameter Bool Control Parameter name -

Parameter Bool Inverted Control Parameter name -

Parameter String Set Parameter name String

Parameter String Control Parameter name -

C.10 Action

Trigger another action.

Feature Function Parameter 1 Parameter 2

Link Set Action -

C.11 Actionlist

Manipulate an actionlist.

Feature Function Parameter 1 Parameter 2

Enable Set Action-list On or Off

Enable Toggle Action-list -

Enable Control Action-list -

Enable Inverted Control Action-list -

C.12 Playback Fader

Control the playback faders.
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Feature Function Parameter 1 Parameter 2

Intensity Decrement Delta (%) -

Intensity Increment Delta (%) -

Intensity Continuous Decrement Delta (%) -

Intensity Continuous Increment Delta (%) -

Intensity Toggle Value (%) Value (%)

Intensity Continuous Bounce Delta (%) -

Intensity Stop Continuous - -

Intensity Control - -

Intensity Set Value (%) -

Speed Control - -

Speed Set Value (%) -

Attack Control - -

Attack Set Value (%) -

FxRate Control - -

FxRate Set Value (%) -

Go+ Set - -

Go- Set - -

Release Set - -

Jump Control - -

Jump Set Cue Number -

C.13 Playback Button

Control the playback buttons.
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Feature Function Parameter 1 Parameter 2

Speed Control - -

Speed Set Value (%) -

Attack Control - -

Attack Set Value (%) -

FxRate Control - -

FxRate Set Value (%) -

Go+ Set - -

Go- Set - -

Release Set - -

Jump Control - -

Jump Set Cue Number -

C.14 Serial

Send data via the RS-232 port on a ArtIO . The Identifier field should contain
the ArtIO’s IP address.

Feature Function Parameter 1 Parameter 2

Send Message Set Text string -

C.15 LED

Set the intensity of a LED on a ArtB6 . The Identifier field should contain the
ArtB6’s IP address.

Feature Function Parameter 1 Parameter 2

Set Set LED index [1,6] Value (%)

Set Control LED index [1,6] -

C.16 GPI

Control the GPI port on a ArtIO or ArtSSC. The Identifier field should contain
the unit’s IP address.

Feature Function Parameter 1 Parameter 2

Refresh Set - -
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C.17 Group

Control the groups. The Identifier field should contain the group’s index.

Feature Function Parameter 1 Parameter 2

Activate Set On/Off -

Activate Control - -

Select Set On/Off -

Select Control - -

C.18 Palette

Control the palettes. The Identifier field should contain the palette’s index.

Feature Function Parameter 1 Parameter 2

Intensity Set Value [0%,100%] -

Intensity Control - -

Position Set Value -

Position Control - -

Colour RGB Set Value -

Colour RGB Control - -

Colour CMY Set Value -

Colour CMY Control - -

Colour Wheel 1 Set Value -

Colour Wheel 1 Control - -

Activate Set On/Off -

Select Set On/Off -

C.19 Universe

Control the universe settings in the patch. The Identifier field should contain
the universe’s index.
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Feature Function Parameter 1 Parameter 2

Master Set On/Off -

Master Toggle - -

Master Control - -

Art-Net Enabled Set On/Off -

Art-Net Enabled Toggle - -

Art-Net Enabled Control - -

C.20 Programmer

Control the programmer.

Feature Function Parameter 1 Parameter 2

Clear Set - -

Clear Selection Set - -

Release All Set - -

C.21 Tempo

Control the BPM tempo. The Identifier field should contain the universe’s index.

Feature Function Parameter 1 Parameter 2

Tempo Set Value (BPM) -

Tempo Control - -

Tempo Toggle Value (BPM) Value (BPM)

Tempo Decrement - -

Tempo Increment - -

C.22 Dashboard Playback Fader

Control the playback fader GUI.
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Feature Function Parameter 1 Parameter 2

LevelPrimair Set Value (%) -

LevelPrimair Control - -

LevelPrimair Inverted Control - -

LevelPrimair Decrement - -

LevelPrimair Increment - -

LevelPrimair Reset - -

Intensity Pickup Set Value (%) -

Intensity Pickup Control - -

Intensity Pickup Inverted Control - -

Intensity Pickup Decrement - -

Intensity Pickup Increment - -

Intensity Pickup Reset - -

Speed Control - -

LevelSecundair Set Value (%) -

LevelSecundair Control - -

LevelSecundair Inverted Control - -

LevelSecundair Decrement - -

LevelSecundair Increment - -

LevelSecundair Reset - -

LevelTertiair Set Value (%) -

LevelTertiair Control - -

LevelTertiair Inverted Control - -

LevelTertiair Decrement - -

LevelTertiair Increment - -

LevelTertiair Reset - -

LevelQuadruple Set Value (%) -

LevelQuadruple Control - -

LevelQuadruple Inverted Control - -

LevelQuadruple Decrement - -

LevelQuadruple Increment - -

LevelQuadruple Reset - -

Play State Set Value (%) -

Play State Control - -

Play State Inverted Control - -

ButtonPrimair Set On/Off -

ButtonPrimair Control - -

ButtonSecundair Set On/Off -

ButtonSecundair Control - -

ButtonTertiair Set On/Off -

ButtonTertiair Control - -

ButtonQuadruple Set On/Off -

ButtonQuadruple Control - -
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C.23 Dashboard Playback Fader Grid

Control the playback fader GUI.

Feature Function Parameter 1 Parameter 2

ButtonSecundair Control - -

C.24 Dashboard Playback Button

Control the playback button GUI.
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Feature Function Parameter 1 Parameter 2

LevelPrimair Set Value (%) -

LevelPrimair Control - -

LevelPrimair Inverted Control - -

LevelPrimair Decrement - -

LevelPrimair Increment - -

LevelPrimair Reset - -

Intensity Pickup Set Value (%) -

Intensity Pickup Control - -

Intensity Pickup Inverted Control - -

Intensity Pickup Decrement - -

Intensity Pickup Increment - -

Intensity Pickup Reset - -

Speed Control - -

LevelSecundair Set Value (%) -

LevelSecundair Control - -

LevelSecundair Inverted Control - -

LevelSecundair Decrement - -

LevelSecundair Increment - -

LevelSecundair Reset - -

LevelTertiair Set Value (%) -

LevelTertiair Control - -

LevelTertiair Inverted Control - -

LevelTertiair Decrement - -

LevelTertiair Increment - -

LevelTertiair Reset - -

LevelQuadruple Set Value (%) -

LevelQuadruple Control - -

LevelQuadruple Inverted Control - -

LevelQuadruple Decrement - -

LevelQuadruple Increment - -

LevelQuadruple Reset - -

Play State Set Value (%) -

Play State Control - -

Play State Inverted Control - -

ButtonPrimair Set On/Off -

ButtonPrimair Control - -

ButtonSecundair Set On/Off -

ButtonSecundair Control - -

ButtonTertiair Set On/Off -

ButtonTertiair Control - -

ButtonQuadruple Set On/Off -

ButtonQuadruple Control - -
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C.25 Dashboard Playback Button Grid

Control the playback button GUI.

Feature Function Parameter 1 Parameter 2

ButtonSecundair Control - -

C.26 Dashboard Bank Fader

Control the playback fader GUI.

Feature Function Parameter 1 Parameter 2

Page Set Page number -

Page Toggle Page number Page number

Page Control - -

Page Decrement - -

Page Increment - -

Page Reset - -

PageUp Control - -

PageDown Control - -

Release - - -

C.27 Dashboard Bank Button

Control the playback fader GUI.

Feature Function Parameter 1 Parameter 2

Page Set Page number -

Page Toggle Page number Page number

Page Control - -

Page Decrement - -

Page Increment - -

Page Reset - -

PageUp Control - -

PageDown Control - -

Release - - -
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C.28 Dashboard Master

Control the grand-master and Blackout GUI.

Feature Function Parameter 1 Parameter 2

LevelPrimair Set Value [0%,100%] -

LevelPrimair Toggle Value [0%,100%] Value [0%,100%]

LevelPrimair Control - -

LevelPrimair Inverted Control - -

ButtonPrimair Set On/Off -

ButtonPrimair Toggle - -

ButtonPrimair Control - -

ButtonPrimair Inverted Control - -

C.29 Dashboard Tempo

Control the BPM tempo GUI.

Feature Function Parameter 1 Parameter 2

ButtonPrimair Set On/Off -

ButtonPrimair Toggle - -

ButtonPrimair Control - -

ButtonPrimair Inverted Control - -

ButtonSecundair Set On/Off -

ButtonSecundair Toggle - -

ButtonSecundair Control - -

ButtonSecundair Inverted Control - -

C.30 Dashboard Selection

Control the fixture selection GUI.

Feature Function Parameter 1 Parameter 2

ButtonPrimair Control - -

ButtonSecundair Control - -

ButtonTertiair Control - -

ButtonQuadruple Control - -
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C.31 Dashboard Programmer

Control the programmer GUI.
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Feature Function Parameter 1 Parameter 2

Record Set On/Off -

Record Control - -

Load Set On/Off -

Load Control - -

Knockout Set On/Off -

Knockout Control - -

Release Set On/Off -

Release Control - -

Dump Set On/Off -

Dump Control - -

Shift Set On/Off -

Shift Control - -

Rename Set On/Off -

Rename Control - -

Blind Set On/Off -

Blind Control - -

Highlight Set On/Off -

Highlight Control - -

Edit Set On/Off -

Edit Control - -

Clear Set On/Off -

Clear Control - -

Page Set On/Off -

Page Control - -

Page Decrement - -

Page Increment - -

PageBeam Set On/Off -

PageBeam Control - -

PagePosition Set On/Off -

PagePosition Control - -

PageColourMix Set On/Off -

PageColourMix Control - -

PageColourFix Set On/Off -

PageColourFix Control - -

PageGobo Set On/Off -

PageGobo Control - -

PageCustom Set On/Off -

PageCustom Control - -

PageMisc Set On/Off -

PageMisc Control - -

PageFrame Set On/Off -

PageFrame Control - -

Wheel Control Wheel index [1,9] -

Wheel Decrement Wheel index [1,9] -

Wheel Increment Wheel index [1,9] -

Wheel Reset Wheel index [1,9] -

Wheel Offset Decrement - -

Wheel Offset Increment - -
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C.32 Dashboard Command

Control the command-line GUI.

Feature Function Parameter 1 Parameter 2

Key ’0’ Control - -

Key ’1’ Control - -

Key ’2’ Control - -

Key ’3’ Control - -

Key ’4’ Control - -

Key ’5’ Control - -

Key ’6’ Control - -

Key ’7’ Control - -

Key ’8’ Control - -

Key ’9’ Control - -

Back Control - -

All Control - -

Minus Control - -

Plus Control - -

Thru Control - -

Full Control - -

At Control - -

Enter Control - -

Period Control - -

C.33 Dashboard Menu

Control the menu GUI.
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Feature Function Parameter 1 Parameter 2

Tab1 Control - -

Tab2 Control - -

Tab3 Control - -

Tab4 Control - -

Status Control - -

Playback Control - -

Matrix Control - -

Memories Control - -

Monitor Control - -

Network Control - -

Patch Control - -

Options Control - -

Power Control - -

Cut Control - -

Copy Control - -

Paste Control - -

Undo Control - -

Redo Control - -

C.34 Dashboard Group Grid

Control the group GUI.

Feature Function Parameter 1 Parameter 2

ButtonPrimair Set On/Off -

ButtonPrimair Control - -

Select Set On/Off -

Select Control - -

C.35 Dashboard Fixture Grid

Control the fixture GUI.
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Feature Function Parameter 1 Parameter 2

ButtonPrimair Set On/Off -

ButtonPrimair Control - -

Select Set On/Off -

Select Control - -

C.36 Dashboard Palette Grid

Control the palette GUI.

Feature Function Parameter 1 Parameter 2

ButtonPrimair Set On/Off -

ButtonPrimair Control - -

Select Set On/Off -

Select Control - -
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Appendix D

API

The EmulationPro is pre-programmed to make its internal functionality avail-
able via OSC. There is a simple API implemented for each protocol. Notwith-
standing this API, it is possible to create your own OSC implementation in the
Memories/Actions menu (see page 30.

D.1 OSC

The following table uses playback #1 as an example. The number ’1’ can be
replaced by any number in the range of [1,8].

URI Parameter Description

/playback-button/level-secundair1 float Control the second level of playback
#1. By default this controls the speed
of the playback.

/playback-button/level-tertiair1 float Control the third level of playback #1.
By default this controls the attack of
the playback.

/playback-button/button-secundair1 float Control the second button of playback
#1. By default this controls the Go+
of the playback.

/playback-button/button-tertiair1 float Control the third button of playback
#1. By default this controls the Go- of
the playback.

/playback-button/bank integer Set the button bank page.

/playback-button/bank-up float Control the button bank increment
button.

/playback-button/bank-decrement float Control the button bank decrement
button.

The following table uses playback #1 as an example. The number ’1’ can
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be replaced by any number in the range of [1,8].

URI Parameter Description

/playback-fader/level-primair1 float Control the slider of playback #1. By
default this controls the intensity of
the playback.

/playback-fader/level-secundair1 float Control the second level of playback
#1. By default this controls the speed
of the playback.

/playback-fader/level-tertiair1 float Control the third level of playback #1.
By default this controls the attack of
the playback.

/playback-fader/level-quaddruple1 float Control the fourth level of playback
#1. By default this controls the
fx-rate of the playback.

/playback-fader/button-primair1 float Control the first button of playback
#1. By default this controls the flash
of the playback.

/playback-fader/button-secundair1 float Control the second button of playback
#1. By default this controls the Go+
of the playback.

/playback-fader/button-tertiair1 float Control the third button of playback
#1. By default this controls the Go- of
the playback.

/playback-fader/button-quaddruple1 float Control the fourth button of playback
#1. By default this controls the
Release of the playback.

/playback-fader/bank integer Set the fader bank page.

/playback-fader/bank-up float Control the fader bank increment
button.

/playback-fader/bank-decrement float Control the fader bank decrement
button.
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URI Parameter Description

/programmer/release float Control the Release button.

/programmer/record float Control the Record button.

/programmer/highlight float Control the Highlight button.

/programmer/dump float Control the Dump button.

/programmer/rename float Control the Rename button.

/programmer/load float Control the Load button.

/programmer/shift float Control the Shift button.

/programmer/blind float Control the Blind button.

/programmer/knockout float Control the Knockout button.

/programmer/clear float Control the Clear button.
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Dump, 41

Edit, 21

Fade In, 23
Fade Out, 23
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Feature, 32, 66
File, 55
Fine Adjustments, 20
Fixture, 9
Flank, 31, 60
Flip, 20
Follow, 23
Forum, 7
Forwarding, 52
Full size, 13
Function, 32, 66
FX, 19
FXRate, 28

Generic Midi-map, 44
Generic Personalities, 9, 56
GPI, 62, 72
GPO, 66
Group, 73
Groups, 16

Halt, 23
Hardware, 39

Indicate, 13
Indicator, 27
Internal timecode, 68
Invert Pan, 11
Invert Tilt, 11

Kiosc, 35, 59

Latitude, 53
Launchpad, 46
Layer, 13
Layout, 12
LED, 72
Licensing, 5
Load, 21
Longitude, 53
Loop, 22
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Manufacturer, 9
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Member, 12
Merge, 20
MIDI, 44, 54, 61, 67
MIDI Clock, 43
Midi-map, 44, 54
Midicon, 44
Midicon2, 44
MidiconPro, 44
Mix mode, 14

nanoKontrol, 48

Options, 53
OSC, 51, 54, 62, 67, 85
Overview, 14

Palette, 73
Palettes, 17
Password, 36
Patch, 8
Pattern, 14, 70
Personality file, 9
Personality Files, 56
PIN, 36
Pixel mapping, 12
Playback Button, 71
Playback Fader, 70
Playbacks, 26
POE, 6
Precedence, 22
Programmer, 18, 74
Properties, 11

Random, 22
Record, 20
Repeat, 22
RS-232, 62, 72

sACN, 8
Scheduler, 33, 61
Selection, 69
Serial, 62, 72
Special, 69
Speed, 27
Starting address, 10
Startup, 61
Sub-Fixtures, 16
Sunrise, 33
Sunset, 33

Swap Pan Tilt, 11
System, 61
System Requirements, 6

Task, 32
Task type, 66
Templates, 30, 59
Tempo, 43, 74
Test Sequence, 24
Time-zone, 53
Timecode, 54, 68
TouchOSC, 51
Tracking, 18
Trigger, 32
Trigger type, 60

UDP, 54, 62, 68
Universe, 8, 73
URI, 62
UTC, 53

Virtual Dimmer, 11

Wait, 23
Wizard, 24

X-Touch Compact, 46
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